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COURSE GOALS 

-Be able to construct a fully-edited news story for broadcast. 

BY THE END OF THIS LESSON PLAN, STUDENTS WILL… 

-Acquire the basic skills necessary for journalists to edit using both Final Cut Pro 7 and Adobe 
Premiere Pro CS6. 

- Correct visual and audio mistakes that were made when the footage was recorded. 

-Be able to edit using the highest quality settings possible, with correct settings. 

-Export to various types of media, depending on what device the video will be played on. 

EQUIPMENT REQUIRED TO EDIT: 

 -An Apple Computer for FCP 

  -Preferably an i7 processor of any generation. 

  -At least 4GB RAM, 8 GB to run smoothly. 

  -A graphics card of at least 512MB. 

  -A copy of Final Cut Pro 7. This module does not cover later versions of this software. 

 -A PC or a Mac for Adobe Premiere Pro CS6 

  -Same specifications as for FCP 

-A copy of Adobe Premiere CS6. This module does not cover later versions of this 
software. 

 -An SD Card, which student-shot footage. 

-An external hard drive of at least 500GB. To make rendering faster, it should have 7200 RPM. 

-Before editing, all footage shall be moved to a safe location on an external hard drive. 

-The format for the hard drive should be ExFAT. This format allows files of any size to 
be moved freely from Mac to PC. 

 

 

 

 

 



TEACHER’S NOTE 

 -Video Editing can be quick and easy to learn, or it can be a very difficult concept to grasp. It all 
depends on each student’s history with computers and file formats. As a result, the learning curve will 
vary greatly between students. Even though this lesson plan is organized, that does not mean it will go as 
planned. In fact, it most likely won’t. 

 -There will be mysterious issues that pop up during the teaching process that no one is able to 
explain, not even the teachers. This is when previously extensive practice with the software is 
recommended – knowing what makes the program work, and where mysterious things tend to go wrong. 
That way, people will know how to solve it. Technology can be very fickle. Experimentation can be a 
good thing, as long as that experimentation, if gone wrong, can be undone. 

 -Video editing is a very hands-on experience. This is not a lecture. This is a workshop. One-to-
one teaching is a necessity. It is best to quickly show students around the software so they do not fumble 
around not knowing what they are doing. But soon after, get them straight to work with footage they have 
hopefully recorded already. The best way to learn video editing is through practice and experimentation. 
Someone else telling you how to do something is not as effective as discovering it yourself.  

 -You are the guides. For students to learn, they must do the work. Otherwise, they will 
continuously ask how features work and never figure out how to do it themselves. 

 -There is so much to learn with these pieces of software; but with only so much time to teach it, a 
lot must be done outside the classroom. Concepts are introduced during class time, but the rest is up to the 
students. Homework should consist of mostly exploration and experimentation. 

-If more time is necessary past the end of class, it is up to the teacher to keep going until enough 
has been done. 

 

FINAL PROJECT 

By the end of the course, the students will have a package fully edited and exported, ready for 
viewing. The due date is a predetermined date after Day 6, or a date in the future if the professor 
feels the need to give students more time. 

 

 

 

 

  



 

 

FCP LESSON PLAN: 

FCP is software released through Apple, therefore it can only be found on Apple computers. As this is the 
introduction to video editing in general, it is best to start with this software, since it is more 
straightforward. The sequence settings and the export settings are easier to understand. Days 1-3 will be 
spent teaching Final Cut software. From Day 4 onward, it will be spent with Adobe Premiere Pro. 

DAY CHRONOLOGY: 

Day 1: Introduction to FCP, and what each of the windows do. Explain what it means to set sequence 
settings. 

Day 2: Discover ways that files are imported into FCP. This requires a full day because of the program’s 
picky nature. From there, show how video is laid onto the Timeline. 

Day 3: The actual editing process begins. This includes filters, motion, wire-framing, clip alterations on 
the timeline, graphics, fixing audio and adding transitions. Finally, show how to export to various forms 
of media. 

 

 

 

 

 

 

 

 

 



DAY 1 

WINDOW LAYOUTS AND FUNCTIONS 

 

     Browser                                                   Viewer   Canvas   

  

     

 

      

Timeline 

 

 

This is the window layout for Final Cut Pro, version 7. These are all the basic windows used for video 
editing.  

 

 

 

 

 

 

	  	  	  

	  



BROWSER 

 

 

 

WHAT THIS FEATURE DOES:  

You can look at footage from multiple projects at the same time, and look at a list of special 
effects… 

 

… Re-name sequences for the Timeline (you can have multiple sequences for the same project.), 

 

 

 

 

 

 

-This is the window you use if 
you want to see a list of footage 
you have imported into the 
program. 

-There is also information for 
each clip such as resolution and 
codec type!  



If you want to change the view of the clips in the Browser, you can do that too! The setting to do 
this can be found underneath the “View” tab at the top of the screen. 

 

 

 

 

 

 

 

 

 

 

It looks just like that! 

You can also view them 
as small icons, medium 
icons, or large icons! 

	  



VIEWER 

 

 

WHAT THIS FEATURE DOES:  

You can open tabs on the top of the window to customize video and audio effects, which are 
found here… 

 

Click on these tabs so you can go to windows where you can do many things! 

 -Fix audio levels (Stereo a1a2) 

 -Make the clip zoom or rotate gradually (Motion) 

 -Change the settings of special effects to specific clips (Filters) 

-Careful! You need to add the effect to a clip first before you can change the 
settings of that clip. Those all can be found… 

  … in “Effects.” 

 

 

 

-The Viewer is where you can 
look at your raw footage and 
set your “ins” and “outs”. 

-You double-click single clips in 
the Browser so you can look at 
them here! 



On the top-left corner of the Viewer, you can see the total length of your currently-selected clip. 

 

On the top-right is where you have placed your marker in that clip. It looks exactly the same as 
the timer on the top-left. 

 

 

 

 

TIMELINE 

 

 

 

 

 

 

 

 

 

 

The bottom-right corner has buttons 
that contain various graphics, mattes 
and texts that you can insert directly 
into the timeline. 

	  

This is the order of progression of all your video clips. It is the most important 
window. This is where you want to order all your clips in the way that you want for 
the final product. The top half is for video, the bottom half is for their accompanying 
audio. 



WHAT THIS FEATURE DOES:  

You can create multiple layers of video and audio on top of each other… 

 

 

 

 

Audio and video can be separated from each other (see: Editing)... 

 

Important: These three top-right tabs make editing on the Timeline easier… 

 

 

 

 

 

 

 

 

 

 

1.	  	  	  	  	  	  2.	  	  	  	  	  	  3.	  	  
1.) Ripple Markers Tool (You do not 
need to change this.) 

2.) Linked Selection Tool 

3.) Snapping Tool 

The video on the top-
most layer is the one 
that is visible on the 
Canvas.	  

	  



TOOLBAR, INCLUDING AUDIO 

Much like Photoshop, this is a list of tools that you can use to change clips on the timeline. Each 
tool’s keyboard shortcuts are in parentheses…. 

 

 

 

 

 

 

 

 

 

 

 

 

CANVAS 

 

WHAT THIS FEATURE DOES:  

You can wire-frame clips you have placed on the timeline. 

 

Selection tool (A), acts like a regular mouse 
cursor. If you click a clip on the timeline, it 
will be selected so the program knows that is 
the clip you want to change 

	  Razor Blade tool (B) lets you slice one 
clip and make it two.	  

Zoom tool (Z) does as it says. It zooms 
into the timeline so you can see each 
frame more clearly. 

Pen tool (P) allows you to gradually 
raise or lower the audio levels in a 
clip. This is done in the Viewer. 

	  

-This displays how 
loud the audio is on 
the clip you are 
playing. 

-Appropriate audio 
levels for interviews 
are always between -
12 and -18 dB. 
Appropriate levels for 
B-roll are always 
below -30 dB. 

	  

	  

Wherever you put your cursor on 
the Timeline, you will see the result 
of that here. Whatever change you 
make, you will see those changes 
here also! 

	  



You can play back your entire timeline using this button… 

 

FILE FORMATTING AND PREPARATION 

 

 

 

 

 

 

IN YOUR EXTERNAL HARD 
DRIVE! 

	  

Remember!	  This	  window	  is	  not	  
where	  your	  files	  are	  living!	  These	  
buttons	  are	  only	  a	  shortcut	  to	  their	  
real	  location.	  



If you delete or move the file from its original location in the hard drive once it is imported into FCP, it 
will go… 

 

… and you can’t use it. 

The best way to keep files organized is to keep it all in one place… an external hard drive. 

 

Make a folder and name it after your project. Then, put it in your hard drive. From there, move every 
piece of footage you have into that folder. From now on, that is where they will stay. 

Now that all your videos are in one safe place, you open FCP and find this tab in the menu... 

 

 

 

 

             

It’s time to set your scratch-disk! 



                                             

 

 

              #1 

          #2 

          #3 

          #4 

 

 

Make sure #1, 2, 3, and 4 are SET to the folder that you just made in your hard drive. This needs to be 
correct every time you start editing… ESPECIALLY if you are sharing the computer with someone else. 

If this is done correctly, you should see THESE in your scratch disk… 

 

They hold a history of what you do in Final Cut. If you lose these folders, your media will go OFF-LINE. 

 

 

 

 

 



DAY 2 

IMPORTING FILES 

There are two ways to import footage into FCP: 

 Importing Files…                                                             … Log and Transfer. 

               

 

Importing Files 

This is done if the camera is compatible with FCP. Take your footage from your SD card (or any memory 
storage device the camera takes) and drag it into the folder you just made. It must stay there forever. 

After that, select “File<Import<Files” in FCP’s top-menu. Find the footage in that folder, and select all 
that you want to keep… 

 

 

 Then select “Choose.” 

 

 

 

 

 

The footage will show up in the “Browser” window, and is ready for editing. 

 



Log and Transfer 

  

FCP is very picky with video formats! If FCP is not letting you import the video files, you have 
to “Log and Transfer.” 

When the Log and Transfer window opens, the footage in the SD card should show up 
automatically, as shown above. 

This feature lets you: 

 Re-name your clips to make them easier to organize.  

 

 

 

 
 
 
 
Set your “in” and “out” points with the  
 
“i” and “o” keys on your keyboard.  

 

 

 

 

 

Cameras that shoot in AVCHD 
format create video files in 
.MTS, which is not readable by 
Macs. 

That is when you use Log and 
Transfer. 



From there, highlight the clips you want to add in the left-section of the window, and either drag them 
down… 

 

…or click… 

  

You must then wait for the files to be converted and moved to your Scratch Disk. 

Most of the time, this is done when a camera shoots in an AVCHD format. “Log and Transfer” converts 
the files to something Final Cut can work with, and then moves it to your Scratch Disk. 

SAVE YOUR PROGRESS 

Save as often as you can. You never know when your hard drive may malfunction. Go to 
“File<Save As,” name the file whatever you like, and save it to the folder you made for your 
project. After that, you only have to click “File<Save All.” 

SEQUENCE SETTINGS 

 

This is one of the most important things you need to make sure is correct BEFORE you move footage 
onto the timeline. 



The raw footage and the timeline in FCP have two different resolution settings. The picture on the 
previous page shows the settings for the Timeline. They are called SEQUENCE SETTINGS. 

You need to make sure these match each other or letterboxes…  

 

… will show up around your footage when looking in the timeline, which is bad. 

 

 

 

You use the “Browser window” list to see what your sequence settings need to be. 

 

Now, you need to check the SEQENCE SETTINGS… 

 

 

 

 

Check the resolution of the raw 
footage in the “Browser.” It will show 
the resolution and aspect ratio, among 
other things.	  

You do not want to 
see these black bars 
when you are editing. 
When this happens, 
your sequence 
settings are incorrect. 



Click this button with the timeline window selected.  

 

Or… 

You can click “Load Sequence Preset” in the bottom-left corner.  

 

 

 

 

Choosing this option will fill everything in for you!  

 

 

If you place anything into the timeline with these settings incorrect, you will get letterboxes. 

MOVING CLIPS ONTO THE TIMELINE 

Double-click a clip in the “Browser” to move it to the “Viewer.” The Viewer will allow you 
to:  

These should be the correct settings 
when editing with HD video in Final 
Cut. 

	  



 

1) Wire-frame the image if it is crooked. Click on the image and a box will appear. Grab the corners to 
expand or shrink the image. Move the cursor next to it and the cursor will allow you to zoom the image 
until it is correct. Rotating will be explained in Day 3. 

 

 
 
 
 
 
 

 

 

 

2) Color-correct the image 
if it is either too light, 
dark, or incorrectly 
colored. 

	  



3) If you did not do it in the “Log and Transfer” window, you can set your “in” and “out” points here. 

4) Move the raw clip straight to the timeline and edit them from there. 

 
 
 

 
 
 
 
 
 
 

 

 

 

 

Having your clip on the Timeline should look like this… 

 

 

 

 

 

IMPORTANT: A window will pop up with this:  
“For best performance your sequence and 
External Video should be set to the format of 
the clips you are editing. Change sequence 
settings to match clip settings?”  

-If you have changed your sequence settings 
already, click NO. 

	  



DAY 3 

EDITING 

Features that editing lets you do: 

1. Move clips along the timeline, or extend them by dragging the edge of the clip. 
 
 

2. Split up the video and audio channels from each other. 

 

With both audio channels selected, go to “Modify< Stereo Pair”. This will unlink 
“A1” from “A2”. You can also do this if you want to delete one channel, but leave 
the other. 

 

 

3. Place clips on top of each other. 

 

 
 
 
 
 
 
 

What if you want to edit only the 
video or only the audio? To do this, 
un-check the Linked Selection Tool. 

Do this when you want to get rid of a 
bad audio channel! 



4. Hide either the video or the audio from the Canvas. 

 

 
5. Split up a clip using the “Razor Blade Tool” 

 

 

6. Put in video/audio transitions in the “Effects” tab from the top-down menu. This will be 
explained later. 

CLIP ALTERATIONS: AUDIO 

 

 

Using the Razor Blade Tool splits one 
clip into two! Now you are able to edit 
one part of a clip while leaving the 
other alone. 

Double-clicking on a selected audio 
clip will open…. 



 

 

When you use a camera with XLR ports, interviews will only be heard out of one speaker, either the left 
one or the right one. Final Cut allows you to fix this! 

 

a. Use the pan to balance out the amount of audio coming out of both the left and right speakers. 
To do this, set “Pan” to 0. 

b. If the audio is either too quiet or too loud, adjust the “Level” until the audio level is between  
-12 and -18 in the audio gauge on the bottom-right corner of the screen… 

You can get more creative here by using the “Pen Tool,” located in the tools window.  

 

…this window here! This window lets 
you adjust audio levels that are too 
high, too low, or are not coming out 
evenly through both speakers. 

Make sure audio 
during interviews are 
in between these two 
numbers as much as 
you can! 

B-roll should 
always be 
below -30 
unless you are 
using a nat-
sound pop! 

-The Pen tool will let you raise or 
lower this line gradually. 

-Doing this will raise the audio or 
video level gradually as well! 



a. With the Pen Tool selected, click on the red line shown on the previous apge. This will create 
a dot on the line. Clicking on another part of that line will make another one. 

b. Once this is done, you can drag these markers up or down to adjust the audio level over the 
course of the clip. 
 

A simpler way to do this… 

 

 

 

 

 

 

 

CLIP ALTERATIONS: VIDEO 

There are countless things you can do in FCP to make sure your video looks as good as possible. But I 
will only go over the basics that a journalist needs to know: 

Color Corrector: 

Double-click the clip you want to change. Then, go here… 

 

 

 

 

 

 

 

With the “Linked Selection” tool 
unchecked, cut a clip with the “Razor 
Blade Tool,” double-click each clip to 
adjust the audio level, and put a 
“Cross Dissolve” in between, located 
in the “Effects” folder. 

A tab will appear on the top of the 
Viewer, which opens to this…	  

Each wheel 
increases either 
blacks, whites, or 
a combination of 
both. But whites 
will be changed 
the most. 



-To make a clip brighter, move one of the bars below the wheels to the right. If you want to make whites 
look brighter, move the bar on the right. To make blacks brighter, move the bar on the left! To make them 
darker, move them to the left instead. 

-To fix the color, drag the knob in the middle of one of the circles to the color that you want to add. 

-Sometimes, if you change the light too much, you will lose color. Increasing the “Saturation” will help 
make up for this. 

 

Wire-frame 

If you are wire-framing after putting it in the timeline, move the cursor over the desired clip, and it will 
instead show up in the canvas. Click the 3rd tab above the video in the Canvas to make sure 
“Image+Wireframe” is checked. 

 

 

Transitions 

 

The staff at San Jose State only uses one kind of transition for both audio and video: Cross Dissolve, or 
Cross Fade for audio. The easiest way to do this is found in the “Altering Clips: Audio” section. 

 

 

 

To zoom in or out, drag one 
of the four corners of the 
picture. To rotate, grab 
anywhere else around the 
border. 



Cut 

 

You can split an individual clip in two using the “Razor Blade Tool”. Directions can be found in the 
beginning of Day 3.  

Zooming and Rotating 

 

STEP 1: Double-click the still in the timeline to bring it to the Viewer. 

STEP 2: Go to the “Motion” tab above the clip in the Viewer.  

 

 

 

 

 

This is when you have a still image 
that you want to use, but you don’t 
want it to stay still. You can zoom in 
and out of the image and focus on 
important words, people, or items that 
you want the viewers to look at. 

	  



STEP 3: Open the drop-down menu labeled “Basic Motion” 

 

Place two dots on a green line for the beginning and end of an animation. If you raise or lower the 
marker on the right, it will create animation. 

If the dots are far away from each other, the animation will be long and slow. 

Scale 

Zooms in or out gradually. 

Rotation 

Rotates the clip or image gradually. 

Center 

This is how far the clip moves along the screen. The left box moves it left or right. The 
right box moves it up or down. 

VIDEO FILTERS 

Color Corrector, explained above, is the most important filter you will use. But there is another filter that 
can be very useful… SMOOTHCAM. 

 

If a clip is shaky, Smoothcam might be able to smooth it out. BUT… IT DOES NOT WORK EVERY 
TIME. Also, the amount of time it takes to apply the filter may take a long time. 

The lines here are the 
amount of motion that 
has been applied to 
the clip. If they are 
completely flat, there 
is no motion! 



LOWER-THIRDS 

 

These graphics are used to identify a person giving a “sound bite,” or introducing a location. They run on 
screen for about 5 seconds, with a Cross Dissolve into and out of the picture. 

  

 

 

 

 

 

 

 

 

 

 

Making one for your own personal reasons is possible, but that takes special software, such as “Motion.” 
That is now San Jose State University makes their own. However, news stations will often provide their 
own. Until then, providing simple text will be enough. 

This is the person’s name. 

This is the font of the text. 

Bold, Italicized, or underlined. 

This is the size of the font. 

This is the person’s 
occupation. 



 

Top Line:             Abbreviated Prefix, Name 

Bottom Line:       OCCUPATION IN CAPS 

Example:              

Prof. Tim Vantress                                                                                           
EDITING MASTER 

 

EXPORTING 

These settings will be different, depending on what type of media you are trying to export to, like for the 
internet, or television, etc. 

But most of the time, it will be exported as a Quicktime movie file format. 

IMPORTANT: These are the recommended settings for the equipment provided by AJEEP. 
They may be different than the proper settings for broadcasting on television in Afghanistan. 

There are two ways to export: 

In the Viewer, there is a 
small button with the letter 
“A” inside… From there, 
select “Text”, then “Lower 
3rd”… 



 

 

This option is straight-forward. When you click “Quicktime Movie,” it will take you to a basic window 
where you can choose the location to save your file to, and re-name it. Finally, you click “Save.” 
Exporting should take only a few minutes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Doing this will export the project 
using the same settings as the timeline, 
but may not be compatible with 
different types of media players. This 
is the quickest export because Final 
Cut was designed to export using this 
option. 

	  

	  

OPTION #1 



 

Choose the location that it will be exported to, and re-name the file. Then click the “Options” button on 
the bottom to get to… 

 

The higher the resolution, the longer it will take to export, and the file size will be bigger . . . but 
the video will be better quality. 

 

 

 

This concludes the Final Cut Pro portion of this module. 

Change the name and 
location you are 
exporting to, then click 
“Save.” 

OPTION #2 

	  

	  

This is the better option. You can 
export it to any device you want! Just 
choose “Quicktime Conversion” 
from the Export menu! 

1. Click “Settings” underneath the 
video section 

This area is where you determine what 
codec to export the file in, and how 
well you want it exported. These 
settings will vary depending on the 
studio. AJEEP uses “Compression: 
H.264.” This is another way to say the 
word, “codec.” 

2. Click “Size” 

In the “Dimensions” tab, the 
recommended settings for the 
computers provided by AJEEP is “HD 
1920 X 1080 16:9” 

Keep “Letterbox” unchecked 



 

ADOBE PREMIERE PORTION OF MODULE 

Note: all of these instructions are using version 6.0 of Adobe Premiere Pro. 

Premiere Pro is software that is more available to people, because it is available on both Mac and PC. It’s 
Exporting options are a bit more complex, but with the right setting, can be done easily. This is the 
program students will be using to edit their projects. 

DAY CHRONOLOGY 

Day 1: Scratch Disks, Sequence Settings and explanation of window layouts. 

Day 2: Importing video into Premiere and moving it onto the Timeline. Then go over how to edit audio. 

Day 3: Explain the other finer points of editing: color correcting, wire-framing, transitions, graphics. 

 

 

 

 

 

 

 

 

 

 

 

 



DAY FOUR 

STARTING A NEW PROJECT  

 

 

-SCRATCH DISKS are also on this screen… 

 

Set these to where your raw footage is on the hard drive! 

When you open the program, this is 
the window that you will see. It is 
asking you what you want your basic 
setup to look like when you open up 
Adobe Premiere Pro. 

All of these should be 
set correctly when you 
open the project, so 
leaving them alone 
would be a good idea. 

But these are important! 
This is where you name 
your project and save it to 
a specific location, which 
is where you will set your 
Scratch Disks 



 

If you do not set them correctly, or if you move to another machine, two things will happen: 

-You will lose a history of your renders. You can play back videos in Premiere without rendering, but it 
will be very difficult to watch smoothly. 

-Most of your files will go offline. You can “re-locate” them again if you want to, but that will take some 
time. 

The next window that will show up is… 

SEQUENCE SETTINGS  

 

  

When choosing sequence 
settings, make sure you 
choose the option that is 
available in your region! 

-For this specific case, use 
this one… 

If you forget to set them 
when you first open a new 
project, you can also do 
them here… 



 

 

For this region, you would want to choose the 1080p 30 fps option, but this varies depending on 
the region. Refer to local television stations for what settings they want. 

WINDOW SETUPS 

 

 Preview Panel             Program Monitor   

 

           Project Panel       Timeline Panel (Plus Tools and Audio levels) 

 

Adobe Premiere Pro windows are very similar to FCP… but with one difference. There are pre-sets called 
“workspaces,” which rearrange the windows automatically for different functions. But these are not 
necessary. 

If you want to edit these settings later, 
this is where you go!	  

	  

	   	  

	   	  



 

         

Every window has an “undock” option, where you can remove it from the pre-set locations and move it 
around the screen freely.  

 

You can also customize the size of each window by dragging the edges in or out. 

 

 

 

 

 

 

However, one option that may be 
useful is “undocking” windows! This 
lets you move the window wherever 
you want. This may be useful if you 
are editing on a small computer 
screen. 



PROJECT PANEL 

 

This window is primarily used to see your collection of clips, their names, and basic file information. You 
can view the video in this window, but the window is very small. It’s better to watch the video in the 
Preview Area. 

WHAT THIS FEATURE DOES:  

Search for names of footage you want to use. 

 

Preview video that is currently 
selected. 



 

Re-name clips to your liking by single-clicking on the clip’s name. 

 

Go to the “Media Browser” tab and search any connected devices for footage that has not been imported 
yet. 

  

 

Organize your footage into 
bins so you can find them 
quicker	  

Though this option is available, it is 
better to import files from the File 
drop-down menu. It gives you more 
room to work with. 

The “Info” tab gives a detailed 
description of files containing raw 
video, such as resolution, fps, and 
what sequence the video has currently 
been placed on. 

	  



Under the “Effects” tab, you can find all the basic video and audio effects and transitions. Many of these 
can be added by simply dragging them to the video on the timeline. 

 

The “History” tab can be very important if you want to correct a mistake made a while ago. 

To bring the raw footage to a bigger preview window with more options, double-click it. 

 

PREVIEW PANEL 

 

This window gives more control of what you want to do with your selected footage before it goes on the 
timeline. You can also adjust your audio and video effects here! 

 

 

 

 

This tab lets you choose an effect to 
add to specific clips, but you cannot 
edit them in this window! That will 
come up later. 



WHAT THIS FEATURE DOES: 

-Play back the un-changed portion of your video. 

 

-Add markers 

-Go forwards or backwards frame-by-frame so you put your in’s and out’s exactly where you want. 

 

-The Effects Controls tab 

 

-If you have any effects added to individual clips, you can adjust these to your liking. Which 
effects to use will be explained later. 

Set “in’s and out’s” similarly to FCP by 
pressing “I” and “O” on the keyboard. Once 
you drag this footage onto the timeline, the 
only footage dragged will be between these 
points	  

You can also have the 
broadcast-safe margins 
visible or not visible.	  



-The “Audio Mixer” tab: 

 

    

PROGRAM MONITOR 

 

WHAT THIS FEATURE DOES: 

Watch clips play back on the timeline by pressing  

-You can play with the settings for the 
selected clip’s audio.	  

	  

The Program Monitor is 
very similar to the Canvas 
in FCP. It lets you play 
your timeline to see what 
your edits look like. 



 

  

 

TIMELINE PANEL 

 

The Timeline Panel is similar to the Timeline in FCP, with only a few small changes. The top portion 
displays the video - the bottom displays the audio. The toolbar, which will be explained later, is now on 
the left side of the Timeline, with the audio levels still on the right side. 

WHAT THIS FEATURE DOES: 

The timeline displays the order of progression of all your video clips.  

 

 

Wire-framing in Premiere is a little 
different. Zooming in or out is the 
same, but rotating is not the same. See: 
“Motion” 

Use this button to export the picture on 
the canvas as a .JPEG	  



 

You can move the clips around…   

 

 

 

 

 

 

… and adjust the video and audio by clicking and holding the yellow line on clips on the timeline. 

 

You can also shrink or expand the width of each audio and video track if they seem too thin by dragging 
the line in between the video and audio. 

 

 

 

 

… Move clips on top of each other… 

The arrows on the left side toggle 
whether you can see the yellow lines. 
If the arrows are pointing left, you 
cannot raise or lower these levels. 



TOOLS OF THE TIMELINE (Keyboard shortcuts are in parentheses) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

-Selection tool (V): acts like a regular 
mouse cursor. If you click a clip on the 
timeline, it will be selected so the 
program knows that is the clip you 
want to change.	  

- Razor tool (C): Cut a clip into two 
different blocks, so you can move and edit 
them individually. 

-Pen tool (P): Similar to FCP, except 
for one exception. You can raise or 
lower audio levels gradually at will, 
but instead of doing this in the “Audio 
Mixer” tab, you can do this directly on 
the timeline. 

-Zoom tool (Z): Zoom in or out of the 
timeline so you can see more at the 
same time. Hold down the “Alt” 
button to toggle between zooming in 
and out. 

The audio gauge on the bottom right is 
exactly the same as in FCP. The gauge 
should consistently be between -12 
and -18. 

-Snap Tool (S) makes it easier to 
remove flash frames. Snaps clips 
together when you move them along 
the timeline. 



DAY FIVE 

IMPORTING VIDEO, EDITING AUDIO 

This process is far simpler than FCP because unlike FCP, Premiere allows for the simple import of the 
AVCHD format. 

 

Find the raw footage in the SD card or storage device that the camera uses, and drag them to where your 
Scratch Disk is. 

IMPORTANT! Before you import these files into Premiere, make sure they are in a PERMANENT 
location.  

 

 

 

 

 

 

 

 

First, put your SD card 
into your laptop and click 
on the SD Card in “My 
Computer”	  

If they are not in a permanent location 
and you move to another machine, 
your video will go OFF-LINE. 

After that, go here to import 
the files you just moved. Now 
it should be in the Project 
Panel.  

From there, double-click on the 
footage you want to put into the 
timeline to bring it to the preview 
panel. 



EDITING AUDIO 

This is slightly different than FCP. 

You do not select an audio clip to edit. They are all shown at the same time by going to this window, 
located in the Preview Panel. 

 

 

Each of the buttons above changes an entire row of audio. If you raise or lower one of these levers, it will 
change the entire row. Make sure interviews are between-12 and -18. 

 

 

 

 

This is the Audio Mixer, where audio 
levels for each channel in the Timeline 
are displayed. 

Unlike FCP, each of these levels does 
not change single clips, but entire rows 
of clips. How to fix individual clips is 
shown on the next page. 

Audio Effects can be 
found in this tab here. 
You can select any of 
these you like, but you 
only need to pay 
attention to a few. 



To change the audio of individual clips, you need to click directly on the audio clip in the Timeline. Move 
the yellow line in the middle of the clip up to raise the volume. Move it down to make it quieter. 

 

If the difference between Channel 1 and Channel 2 is not even: 

Go to the “Effects” tab in the Raw Video Window, drop down to the “Audio Effects” section. From 
there, choose “Fill Left” or “Fill Right.” This depends on which channel needs filling. 

 

 

 You can also add an “Audio Transition,” which in this case the best option is “Cross-fade.” 

 

 

 

 

 

 

 

 

 

 

“Fill Left” and “Fill Right” can also 
be used to keep both audio channels 
full while deleting a bad channel on 
the timeline. 



DAY SIX  

EDITING VIDEO 

Color Corrector 

 

To find the Color Corrector, you go to the “Effects” Tab in the Project Panel and type in “three” in the 
search bar. Then, drag “Three Way Color Corrector” to the clip you want to fix. 

From there, double-click on the clip on the timeline to bring it to the Video Preview Window, then select 
the “Effects Controls” tab. You should then see the window above. 

 

 

 

Drag the dot in each of the three color 
windows to adjust the color!	  

To fix the brightness, 
move the bars below it to 
either the left or the right! 



Wire-Framing 

 

This is slightly different than FCP. To open the fire-framing window, double-click the video in Program 
Monitor and you will see the above image. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

To rotate an image, hover your mouse 
just beyond the two middle boxes until 
the icon changes. Then, click and drag 
wherever you want to go! 



Video Transitions and Effects 

These are accessed in the same area that the Color Corrector can be found: in the “Effects” tab in the 
Project Panel window.  

The one used most-often is the Cross-Dissolve.  

 

 

 

For video effects, you do the exact same thing. You click on the video effect or transition you want, and 
drag it to the video clip on the timeline. 

Zooming and Rotating (Motion) 

 

This process is almost the exact same as FCP: 

Make sure the red line in the timeline is on the clip you want to change, then go to “Effects Controls.” 

 

If you want to use a video transition or 
video effect, double-click the 
transition in the project panel and drag 
it between the two clips you want to 
transition to and from.	  



-Under the “Video Effects” section, there are the same options as in FCP. All of the changes you make 
are visible in the Program Monitor: 

Position: Move the video left or right, up or down. The first number changes horizontal 
movement, the second number changes vertical movement. 

Scale: This zooms the image in or out. 

Rotation: A wheel will show up where you can change the degree of the image angle. For 
example, dragging the line in the wheel ¼ of the way around will spin the image 90 degrees. 

Although the basic functions are the same as FCP, there is one difference. 

 

 

To erase the markers, you click the timer button again. 

LOWER-THIRDS 

The same rules apply for lower-thirds using Adobe Premiere Pro. You cannot have a lower-third with 
fancy graphics unless they are made with other software, or were previously made from a station. 

For now, create a basic lower-third by going to… 

 

Clicking this button next to position, 
scale, or movement will create a 
keyframe.	  

These keyframes signify the beginning 
and end of a specific animation. You 
then apply the amount of animation 
you want in between these markers. 



 

That will take you to this window here… 

 

The fun begins on the next page! 

 

 

 

 

 

 

 

	  
Make sure that the width 
and heath match your 
sequence settings! 

The first thing you do on 
this window is click once 
on the picture in the 
middle. That will create a 
text box! 



This window lets you customize your text. I will point out the features that are the most important. 

 

 

As soon as you opened this window, a copy was sent to the Project Panel. Drag it onto the timeline, on 
top of the sound bite you want it for. 

 

This is how visible your 
lower-third is. The lower 
this number is, the less 
visible the text is. 

This changes your style of 
font. 

This changes the font from 
Bold, Italicized, or plain. 

This changes the size of the 
text. 

This changes the color of 
the text. 



RENDERING 

 

Rendering in Premiere is much simpler than FCP.  

-Depending on the video format, some clips may have trouble playing back in the timeline if it is not 
rendered. This does not happen often. But when it does, select all the clips you wish to render in the 
Timeline, and then press “Enter.” 

-A window will pop up telling you how much longer the render will take. 

-Before your export, MAKE SURE EVERYTHING IS RENDERED! IF NOT YOUR EXPORT 
WILL NOT WORK PROPERLY! 

 

 

 

 

 

 

 

 

 

 

 



EXPORTING MEDIA 

 

*For export settings, refer to technicians at the local television stations for what settings they prefer. 

Exporting in Premiere can be a good thing or a bad thing. That’s why you need to be extra careful when 
exporting in Premiere. 

You have more options and less room for error. You have the freedom to change any setting you like, but 
you will not know if it was the wrong setting until after it is exported. 

To go to the above window, go here underneath the “File” tab… 

 

 

 



EXPORT WINDOW 

 

Once you are done with changing your settings, you click Export. 

 

BEFORE YOU CHANGE ANY EXPORT SETTINGS, YOU MUST CHOOSE A FORMAT. 
THAT IS THE MOST IMPORTANT SETTING. 

 

The format setting determines which devices this video will be able to play on. For instance, if you 
choose .AVI, you cannot play your video on a Mac.  

Some formats reduce quality. The goal here is to keep quality as high as possible and make your video 
available for as many devices as possible. 

This is one of the things studios do differently. Some may use one format, while another may use 
something else. 

…the best choice for a format is… 

 

The “H.264” format lets you play it on almost everything. The preset button just below it has by far the 
most options for exporting available, such as phones, tablets, all different kinds of PC’s, and streaming on 
the internet. 

Here is a video 
preview of 
everything you will 
be exporting. Scroll 
through the meter 
below it to make 
sure everything 
looks correct. 

Here is the area 
where you 
change the 
export settings. 



 

 

 

BE CAREFUL OF THE SETTINGS ALLOWED IN YOUR REGION 

The settings for PAL and NTSC are slightly different. If you are in the United States, the setting to use is 
NTSC. Anywhere in Europe and the Middle-East uses PAL. 

Once you click “Export,” it should only take a few minutes until it is done. When that happens, play back 
the video to make sure it is correct! 

OR… 

There is a fool-proof setting to make sure you do not mess up the export. 

 

There is one problem with exporting like this… if you do this, you cannot control what device your video 
can play on. It usually exports to .AVI, which is the format mostly associated with Windows machines. 

That is the end of the video editing module! 

This is what the name of 
your video is going to be. 

These are your current sequence 
settings. Make sure the resolution and 
k(Hz) settings for the “Output” and the 
“Source” are the same! 

Check this box so the export settings 
match the sequence settings exactly! 

	  


